
Managing Address Space

Address blocks provide an organizational structure for addresses used across the network. Address blocks
can consist of static addresses or dynamic addresses allocated to DHCP servers for lease assignment. An
address block can have any number of child address blocks and can culminate in one or more child subnets.
The address block administrator is responsible for these objects. This administrator can create parent and child
address blocks or subnets, which are always the leaf nodes of the address space. Static subnets can be further
subdivided into one or more IP address ranges. However, dynamically added subnets create their own subnets
that the administrator cannot modify or delete.

For IPv6 address management, see Viewing IPv6 Address Space, on page 14.Note

• Address Block Administrator Role, on page 1
• Address Blocks and Subnets, on page 2
• Pulling and Pushing, on page 9
• Viewing Address Space, on page 11
• Generating Utilization History Reports, on page 17

Address Block Administrator Role
The address block administrator role manages address space at a higher level than that of specific subnet or
static address allocations. This is actually a middle manager role, because there is likely to be a higher authority
handing out address blocks to the system.

Related Topics
Required Permissions, on page 1

Role Functions, on page 2

Required Permissions
To exercise the functions available to the address administrator, you must have at the:

• Regional cluster—The regional-addr-admin role assigned. This role should probably be unencumbered
by further subnet-utilization, lease-history, and dhcp-management subrole restrictions.
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• Local cluster—The addrblock-admin role assigned.

Role Functions
These functions are available to the address block administrator at the:

• Regional cluster:

• Address aggregation. For example, if the 10.0.0.0/16 address block exists at the regional cluster and
a local cluster administrator creates the 10.1.1.0/24 address block, the local address block (through
replication) is rolled up under its parent at the regional cluster. This allows a unified view of the
address space at the regional cluster without affecting the local cluster configuration.

• Address delegation. Administrators can delegate address space to the local cluster, thereby giving
up authority of the delegated object.

• DHCP utilization reports. The regional cluster supports DHCP utilization reporting across regions,
protocol servers, and sets of network hardware. The central configuration administrator can poll the
local clusters for DHCP utilization by virtual private network (VPN), if defined, time range, and
criteria that contain the following choices: owner, region, address type, address block, subnet, or
all. For details on querying DHCP utilization, see Querying Utilization History Data, on page 17.

• Lease history reports. This provides a single vantage point on the lease history of multiple DHCP
servers. The administrator can query the history data at the local cluster to constrain the scope of
the history report. Lease histories can be queried by VPN (if defined), time range and criteria that
contain the following choices: IP address, MAC address, IP address range, or all. This is an important
feature to meet government and other agency mandates concerning address traceability. For details
on querying lease history, see Querying Leases.

• Polling configurations. The administrator can control the intervals and periods of local cluster polling
for replication, IP histories, and DHCP utilization. You can also set the lease history and DHCP
utilization trimming ages and compacting intervals at the CCM server level. (See the "Managing
the Central Configuration" chapter in Cisco Prime Network Registrar 10.1 Administration Guide)

• Check the DHCP and address data consistency.

• Local cluster:

• Manage address blocks, subnets, and address types.
• Check the DHCP and address data consistency.

Address Blocks and Subnets
An address block is an aggregate of IP addresses based on a power-of-two address space that can be delegated
to an authority. For example, the 192.168.0.0/16 address block (part of the RFC 1918 private address space)
includes 216 (or 65536) addresses. Address blocks can be further divided into child address blocks and subnets.
For example, you might want to delegate the 192.168.0.0/16 address block further into four child address
blocks—192.168.0.0/18, 192.168.64.0/18, 192.168.128.0/18, and 192.168.192.0/18.
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The DHCP server also uses address blocks to manage subnet allocation for on-demand address pools
(see Configuring Subnet Allocation). Address blocks used for dynamic address pools must be created
using the dhcp-address-block command in the CLI. The unified address view in the webUI also displays
these dynamic address blocks, but does not provide an edit link to them, because they have been delegated
in their entirety to the DHCP server. They should not be further subdivided for subnet allocation. The
DHCP server automatically handles these address blocks as it receives subnet requests. These address
pools are indicated by a D (for “Delegated”).

Note

A subnet is the leaf node of the address space and cannot be further subdivided. If you create the
192.168.50.0/24 subnet, you can subsequently create an address block by that same name, and the subnet will
become a child of the address block. However, you cannot further subdivide or delegate the 192.168.50.0/24
subnet.

Subnets can have one or more defined address ranges. Address blocks cannot have address ranges. When you
create an address range for a subnet by using the web UI, it becomes a static range, meaning that it cannot be
allocated dynamically using DHCP. However, the web UI shows any dynamic ranges defined by DHCP
scopes for the subnet. Displaying the ranges as such indicates where overlaps may occur between assigning
static addresses for the address space and dynamic addresses for scopes.

The address space view shows the hierarchy of address block and subnets and their parent-child relationships.
The hierarchy does not go down to the level of address ranges for each subnet. These are displayed when you
access the subnet.

Related Topics
Viewing Address Blocks, Subnets, and Address Types, on page 13

Knowing When to Add Address Blocks, on page 4

Adding Address Blocks, on page 5

Delegating Address Blocks, on page 7

Pushing Subnets to Local DHCP Servers and Routers, on page 10

Creating Reverse Zones from Subnets, on page 7

Reclaiming Subnets, on page 7

Adding Children to Address Blocks, on page 8

Adding Address Ranges to Subnets, on page 9

Viewing Address Utilization for Address Blocks, Subnets, and Scopes, on page 11

Subnet Allocation and DHCP Address Blocks
Cisco Prime Network Registrar supports creating on-demand address pools as a network infrastructure for
address provisioning and VPNs. Traditionally, the DHCP server is limited to interact with individual host
devices. Through subnet allocation, the server can interact with VPN routers and other provisioning devices
to provision entire IP subnets. This Cisco Prime Network Registrar feature enhances the on-demand address
pool capability currently supported by the Cisco IOS Relay Agent.
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Cisco Prime Network Registrar supports explicitly provisioned subnets. You must explicitly configure the
DHCP server address space and subnet allocation policies before the server can allocate pools or leases. You
can thereby configure a server as a pool manager to manage subnets and delegate them to client devices.

You manage DHCP subnet allocation using DHCP server address block objects in Cisco Prime Network
Registrar. A DHCP address block is a range of contiguous IP addresses delegated to the DHCP server for
assignment. The server expects to subdivide these addresses into pools so that it or other servers or devices
can allocate them. DHCP address blocks are parents to subnets. These DHCP address blocks are distinct from
the address blocks you can create using the Cisco Prime Network Registrar web UI, which are static. DHCP
address blocks cannot include static address ranges or lease reservations.

The image below shows a sample environment where a DHCP server allocates entire subnets to access
concentrators or other provisioning devices, in addition to servicing individual clients. The traditional
client/server relationship is shown on the left of the diagram, while the subnet allocation to access concentrators
is shown on the right of the diagram. Dialup customers, for example, connect to the service provider network
at two ISP gateways (routers), which connect to the management network segment where the DHCP server
resides. The gateways provision addresses to their connected clients based on the subnet requested from the
DHCP server.

Figure 1: Sample DHCP Subnet Allocation Configuration

Knowing When to Add Address Blocks
This use case describes the set of user actions associated with adding a new address block to the network in
a shared management network. These preconditions are assumed:

1. From summary IP address utilization reports, an address block administrator notes that the top level
address block of the company is nearing the 90% utilization mark.

2. The address block administrator submits a request for more address space from ARIN (or some other
numbering authority) and the request is granted.

Once the address space is made available, the regional address administrator:

1. Adds the new blocks to the central address block map, and based on a review of the utilization reports,
creates and delegates address blocks to be used by the local clusters. The action of delegating the address
blocks causes them to be pushed to the local clusters.

2. Allocates the new address space to network elements as needed using failover synchronization to simplify
the configuration tasks:
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Allocates subnets to a failover pair (gets a scope template for the subnet, either from the subnet or
the failover pair).

•

• Finds a free subnet (finds the address block of the right type).
• Allocates the free subnet to an address destination (DHCP server or other destination).

Adding Address Blocks
Once you configure your network, you can add DHCPv4 address blocks.

Local Advanced and Regional Advanced Web UI
To view the CCMaddress blocks, from theDesignmenu, chooseAddress Blocks under theDHCPv4 submenu
to open the List/Add DHCP Address Blocks page.

To add an address block, click the Add Address Block icon in the Address Blocks pane on the left. Enter its
network address in the Address field, then choose the address mask from the drop-down list. For example,
enter 192.168.50.0 in the Address field, then choose 24 in the drop-down list to create the 192.168.50.0/24
address block, which is all the addresses in the range 192.168.50.0 through 192.168.50.255.

For a review of the number of available addresses for each subnet mask, see the table below. These available
hosts exclude the two network and broadcast addresses in each range.

Table 1: Subnet Masking

Available Hosts in Each Address RangeOctet DesignationNetwork Mask

16777214255.0.0.0/8

8338606255.128.0.0/9

4194302255.192.0.0/10

2097150255.224.0.0/11

1048574255.240.0.0/12

524286255.248.0.0/13

262142255.252.0.0/14

131070255.254.0.0/15

65534255.255.0.0/16

32766255.255.128.0/17

16382255.255.192.0/18

8190255.255.224.0/19

4084255.255.240.0/20

2046255.255.248.0/21
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Available Hosts in Each Address RangeOctet DesignationNetwork Mask

1022255.255.252.0/22

510255.255.254.0/23

254255.255.255.0/24

126255.255.255.128/25

62255.255.255.192/26

30255.255.255.224/27

14255.255.255.240/28

6255.255.255.248/29

2255.255.255.252/30

CLI Command
Use address-block [vpn-name/]address/mask create [attribute=value ...]. For example:
nrcmd> address-block 192.168.0.0/16 create

Configuring Private Networks in VPN for a Tenant
To configure the private networks in VPN for a tenant, do the following:

Regional Advanced Web UI

Step 1 Select the required tenant from the Tenant sub menu under the Settings drop–down list at the top of the web UI.
Step 2 Select the required VPN from the VPN sub menu under the Settings drop–down list at the top of the web UI.
Step 3 Navigate to the Design menu and choose VPNs under the DHCP Settings submenu to open the List/Add VPNs page.

Set the Tenant-Private-Network attribute to true. This attribute indicates that this VPN represents the tenant non-routable
(RFC1918) addresses on a local cluster.

It applies only to regional CCM clusters and will be ignored if set on a local cluster.Note

Step 4 Create the private address blocks (for example, 10.0.0.0/24).

CLI Commands
Use session set attribute=value to set tenants and VPNs. Use vpn name set tenant-private-network=value
to indicate that this VPN represents the tenant non-routable addresses on a local cluster. Then, create the
private address block using address-block [vpn-name/]address/mask create. For example:
nrcmd-R> session set tenant=t1

nrcmd-R [Tenant:t1]> session set vpn=vpn1
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nrcmd-R [Tenant:t1 VPN:vpn1]> vpn vpn1 set tenant-private-network=true

nrcmd-R [Tenant:t1 VPN:vpn1]> address-block 10.0.0.0/24 create

Delegating Address Blocks
Address block delegation is the coordinated actions of marking the delegated address block at the regional
cluster as being delegated to a local cluster and creating the delegated address block in the local cluster. To
delegate an address block to a local cluster, the address block cannot have child address blocks or subnets.
The delegated address block created at the local server must have the same address size as the one at the
regional cluster.

You can delegate only one address block to one local cluster at a time; you cannot delegate it to multiple local
clusters. You can also delegate an address block to an owner.

To delegate an address block, you must:

1. Have the central configuration administrator create a local cluster to which to delegate the address block
(see the “Configuring Server Clusters” section in Cisco Prime Network Registrar 10.1 Administration
Guide).

2. Have the central configuration administrator synchronize the regional cluster with the local cluster (see
the “Synchronizing with Local Clusters” section in Cisco Prime Network Registrar 10.1 Administration
Guide). The local cluster will have address source references to the regional cluster through the
synchronization process.

3. Delegate the address block to the cluster or an owner.

CLI Command
When connected to a regional cluster, you can use the address-block name delegate cluster-name command.

Creating Reverse Zones from Subnets
You can create reverse zones from subnets directly on the List/Add Subnets page instead of having to do so
manually (see the "Adding Reverse Zones from Subnets" section in Cisco Prime Network Registrar 10.1
Authoritative and Caching DNS User Guide). Click the Reverse Zone tab and choose a configured zone
template from the drop-down list, then click Report to show the changesets for the creation. Confirm the
creation by clicking Run.

Related Topics
Reclaiming Subnets, on page 7

Adding Address Ranges to Subnets, on page 9

Viewing Address Utilization for Address Blocks, Subnets, and Scopes, on page 11

Pushing Subnets to Local DHCP Servers and Routers, on page 10

Reclaiming Subnets
Once you delegate a subnet to the DHCP server or router, you can reclaim it if necessary.
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Local Advanced and Regional Web UI

Step 1 From the Design menu, choose Subnets under the DHCPv4 submenu to open the List/Add Subnets page.
Step 2 Select the subnet from the Subnets pane on the left to open the corresponding Edit Subnet page.
Step 3 Click Reclaim at the top of the page. This opens the Reclaim Subnet page.
Step 4 If you want to force deleting the subnet, check the Force Delete check box.
Step 5 Click Reclaim Subnet.

When you push or reclaim subnets for a managed or virtual router, this sets the primary and secondary
relationships that are set for the router for all the related subnets and scopes as well. For details on routers, see
the "Pushing and Reclaiming Subnets for Routers" section in Cisco Prime Network Registrar 10.1 Administration
Guide.

Note

CLI Command
When connected to a regional cluster, you can use the subnet name reclaim [-force] command.

Adding Children to Address Blocks
You might want to subdivide undelegated address blocks into child address blocks or subnets.

Local Advanced and Regional Advanced Web UI

Step 1 From theDesignmenu, chooseAddress Blocks under theDHCPv4 submenu to open the List/Add Address Blocks page.
Step 2 Click the name of an address block that is not marked as delegated (D). This opens the Edit Address Block page.
Step 3 To add a child address block, add an address that is part of the address block network address in the Address/Mask field

of the Child Address Blocks section. Choose a higher mask value than the parent address block, then click Add.

An error message appears if you try to set the same network address for a child address block as for a child subnet.

Omitting a value when you clickAdd automatically adds the subdivisions of the parent address space with the appropriate
mask value. For example, if the parent space is 192.168.50.0/24, you omit any child subnet value, and click Add, the
web UI adds the children in this order:

192.168.50.0/26

192.168.50.64/26

192.168.50.128/26

192.168.50.192/26

Step 4 To add a child subnet, add an address in the Address/Mask field of the Child Subnets section of the page that is part of
the address block network address, but choose a higher mask value than the parent address block. Then click Add.

An error message appears if you try to set the same network address for a child address block as for a child subnet.
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If you omit a value when you click Add, this automatically adds the subdivisions of the parent address space with the
appropriate mask value. For example, if the parent space is 192.168.50.0/24, you omit any child subnet value, and click
Add, the web UI adds the children in this order:

192.168.50.0/26

192.168.50.64/26

192.168.50.128/26

192.168.50.192/26

Adding Address Ranges to Subnets
You can edit the subnet data and add any number of address ranges to a subnet. These ranges must be in the
designated network of the subnet.

Local Advanced and Regional Web UI

Step 1 From the Design menu, choose Subnets under the DHCPv4 submenu to open the List/Add Subnets page.
Step 2 Click the name of the subnet to which you want to add address ranges, in the Subnets pane on the left. This opens the

Edit Subnet page.
Step 3 Enter the starting address of the range in the Start field in the IP Ranges area of the page, then add the ending address in

the End field. If you add just the host numbers in these fields, the relative address in the range determined by the address
mask is used.

Step 4 Click Add IP Range.
Step 5 Click Save to save the changes.

Pulling and Pushing

Pulling Replica Address Space from Local Clusters
You may choose to pull address space from the replica data of the local clusters instead of explicitly creating
it.

Pulling replica address space from a local cluster where IPv4 subnets were removed does not clear the
server name on the subnet. Although the subnet is no longer used, it is still considered allocated to the
server. Hence, the delete operation does not appear for the subnet, so that you cannot delete the subnet
from the regional cluster. To push or reallocate the subnet to a different cluster, or remove it from the
regional cluster, you must first reclaim the subnet (see Reclaiming Subnets, on page 7). This clears
the reference to the local server.

Note
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Regional Advanced Web UI

Step 1 In the DHCP Address Tree (or DHCPv6 Address Tree) page, click the Pull Data icon in the Address Tree pane.
Step 2 In the Select Pull Replica Address Space (or Select Pull Replica IPv6 Address Space) page:

• To omit reservations while pulling replica, check the Omit Reservations check box.
• Select the Data Synchronization Mode (Update, Complete or Exact)

Step 3 Click Report at the top or bottom of the page.
Step 4 Confirm the summary and click OK.

CLI Commands
When connected to a regional cluster, you can use the following pull commands:

• ccm pullAddressSpace < update | complete | exact > [-omitreservations] [-report-only] [-report]

• ccm pullIPv6AddressSpace < update | complete | exact > [-report-only] [-report]

Pushing Subnets to Local DHCP Servers and Routers
You can push subnets to local DHCP servers and routers.

Local Advanced and Regional Web UI

Step 1 Have the central configuration administrator create a local cluster and resynchronize it with the local cluster.
Step 2 Create a subnet at the regional cluster:

a) From the Design menu, choose Subnets under the DHCPv4 submenu. This opens the List/Add Subnets page.
b) Click the Add Subnet icon in the Subnets pane on the left.
c) Enter at least the network address and choose the mask of the subnet, then click Add Subnet.

Step 3 Have the central configuration administrator create a scope template so that it can create a scope to contain a subnet:
a) Log into the regional cluster as the central configuration administrator.
b) From the Design menu, choose Scope Templates under the DHCPv4 submenu to open the List/Add DHCP Scope

Templates page.
c) Click the Add Scope Templates icon in the left pane, to open the Add DHCP Scope Template page.
d) Enter the name for the scope template and click Add Scope Template.
e) In the Edit DHCP Scope Template scopename page, among other entries on this page, enter the create-range

expression in the Range Expression field to create a scope with that subnet. (If you choose a policy for the scope
template, be sure that the policy exists at the local cluster, or you must push the policy to the local cluster. See the
"Pushing Policies to Local Clusters" section in Cisco Prime Network Registrar 10.1 Administration Guide.)

Step 4 As regional address administrator, add the subnet to the local cluster DHCP server:
a) Log into the regional cluster as the regional address administrator.
b) From the Design menu, choose Subnets under the DHCPv4 submenu to open the List/Add Subnets page.
c) Select the subnet from the Subnets pane on the left, to open the corresponding Edit Subnet page.
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d) Click Push at the top of the page. This opens the Push Subnet page.
e) Choose the scope template from the drop-down list.
f) Choose the router and the router interface from the drop-down lists.
g) Choose the cluster from the drop-down list.
h) Click Push Subnet.

CLI Command
When connected to a regional cluster, you can use the subnet name push cluster/failover-pair
[-template=template-name] command.

Viewing Address Space
The address space is a hierarchical tree of address blocks and subnets in IPv4 and prefixes in IPv6, sorted in
IP address order. You can choose the level of depth at which to display the tree. You can also expand and
contract nodes, which recursively expands or contracts all child nodes. If you pick a new level, this overrides
the previous expansion or contraction.

Local Advanced and Regional Advanced Web UI
To view the address space as a hierarchical tree:

• From the Design menu, choose Address Tree under the DHCPv4 submenu to open the DHCP Address
Tree page. Note that you can choose a VPN (if configured).

• From theDesignmenu, chooseAddress Tree under theDHCPv6 submenu to open the DHCP v6Address
Tree page. Note that you can choose a VPN (if configured).

Viewing Address Utilization for Address Blocks, Subnets, and Scopes
You can view the current address utilization for address blocks, subnets, and scopes.

For address utilization for IPv6 prefixes, see Viewing Address Utilization for Prefixes, on page 14.Tip

Local Advanced and Regional Advanced Web UI
The function is available on the DHCPAddress Tree page, List/AddDHCPAddress Blocks page, and List/Add
Subnets page. When you click the Current Usage tab, the utilization detail appears.

To ensure the proper subnet-to-server mapping on this page, you must update the regional address space
view so that it is consistent with the relevant local cluster. Do this by pulling the replica address space,
or reclaiming the subnet to push to the DHCP server (see Reclaiming Subnets, on page 7). Also ensure
that the particular DHCP server is running.

Note

The other columns in the Current Usage tab identify:
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• Type—Whether the address space is an address block, subnet, or scope.

• Utilization—Displays a progress bar which indicates the usage and availability of addresses.

• View Utilization History—Appears at the regional cluster only. Clicking the Report icon ( ) opens
the Utilization History Details page.

In the Current Usage tab, the Utilization Detail column items are expandable so that you can view the scope
data for an address block or subnet. If you click the View Details icon ( ) next to the address block, subnet,
or scope name in this column, this opens the Utilization Details page for selected item.

The Utilization Details page is read-only, and shows detailed address utilization attributes for the address
block, subnet, or scope in the form of chart and table. If you want to drill down to the actual breakup of the
usage, you can click the View Details icon on the row and an overlay with the breakup in the form of a chart
with appropriate legends is displayed. You can hover on different parts of the chart to get more details about
that particular type of usage. Click the Table tab to view the address utilization attributes described in the
table below.

Table 2: Address Utilization Attributes

DescriptionUtilization Attribute

The tenant organization or group that is associated with the administratorTenant

Granularity of this utilization data. The scope-level is the most detailed data
available from the DHCP server. Aggregated counters are reported at the
subnet-level and addr-block-level or at the network-level. These are the sum
of scope-level data in a given subnet, address block, or network.

aggregation-level

Total Addresses

Total number of leases, excluding reserved ones.total-dynamic

Total number of reserved leases.total-reserved

Free Dynamic

Number of dynamic leases that are currently available for issue to clients.avail

Number of dynamic leases that the DHCP failover partner currently has
available for issue to clients.

other-avail

Active Dynamic

Number of dynamic leases that are currently offered to clients, but not yet
acknowledged as being leased.

offered

Number of dynamic leases that are currently acknowledged as leased to clients.leased

Number of dynamic leases that are past the lease expiration period, but will
not be available for other clients (except after the policy grace-period expires).

expired

Number of dynamic leases that are waiting acknowledgement from the failover
partner that it did not reissue the lease.

pend-avail
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DescriptionUtilization Attribute

Reserved

Number of reserved leases that clients are actively using.reserved-active

Number of reserved leases that clients are not actively using.reserved-inactive

Unavailable

Number of unreserved dynamic leases that a client declines or the server marks
with an address conflict (usually indicating configurations that need correcting).

unavail

Number of reserved leases that a client declines or the server marks with an
address conflict (usually indicating configurations that need correcting).

reserved-unavail

Deactivated

Number of dynamic and reserved leases that clients are actively leasing (that
are not offered, expired, or released), but that an administrator deactivated.

deactivated

Number of dynamic leases that clients are actively leasing (that are not offered,
expired, or released), but that an administrator deactivated.

leased-deactivated

Number of reserved leases that clients are actively leasing (that are not offered,
expired, or released), but that an administrator deactivated.

reserved-leased- deactivated

Additional Attributes

The primary-subnet for this subnet-level or scope-level utilization data.primary-subnet

The comma-separated list of selection tags associated with scope-level
utilization data.

selection-tags

Viewing Address Blocks, Subnets, and Address Types
You can view the address blocks and subnets created for a network.

Local Advanced and Regional Advanced Web UI
From the Design menu, choose Address Tree under the DHCPv4 submenu to open the DHCP Address Tree
page.

To choose a level of depth for the address space, click one of the addresses in the Address Tree pane on the
left. The details about the address appear in the page. The Address Type column identifies the type of object
displayed, an address block or a subnet. The Owner column identifies the owner of the address space, and the
Region column identifies the assigned region for the address space.

Address spaces that were assigned dynamically are indicated by a D (for “Delegated”) in the Address Type
column. You cannot delete this delegated address space.

To refresh the view, click the Refresh icon.

You can add, modify, and delete address types. From the Design menu, choose Address Types under the
DHCP Settings submenu to open the List/Add Address Types page. Click the Add Address Types icon in
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the Address Types pane on the left to open the Add Address Space Type page, and modify settings on the
Edit Address Type page. You can also pull replica address types, push address types, and reclaim address
types on the List/Add Address Types page.

CLI Commands
Use address-type name create [attribute=value] to create the address types.

Use address-type name delete to delete the addres types.

When connected to a regional cluster, you can use the following pull, push, and reclaim commands. For push
and reclaim, a list of clusters or "all" may be specified.

• address-type < name | all > pull < ensure | replace | exact > cluster-name [-report-only | -report]
• address-type < name | all > push < ensure | replace | exact > cluster-list [-report-only | -report]
• address-type name reclaim cluster-list [-report-only | -report]

Viewing IPv6 Address Space
From theDesignmenu, chooseAddress Tree under theDHCPv6 submenu, in the local advanced or regional
advanced web UI, to view the DHCP v6 Address Tree page. This page is like the DHCP Address Tree page
for IPv4 (see Viewing Address Space, on page 11). On the View Unified v6 Address Space page you can:

• Set a VPN for the address space from the VPN submenu under the Settings drop-down list at the top of
the web UI.

• Add a prefix by clicking the Add IPv6 Prefix icon in the Address Tree pane, enter the prefix name,
address, and choose a prefix type and prefix template. Click Add IPv6 Prefix (see Creating and Editing
Prefixes).

• Edit a prefix by selecting its name in the Address Tree pane. This opens the Edit Prefix page (see Creating
and Editing Prefixes).

• View the current usage of the prefix space (see Viewing Address Utilization for Prefixes, on page 14).

Viewing Address Utilization for Prefixes
You can view the current address utilization for prefixes.

Local Advanced and Regional Web UI
The function is available on the DHCP v6 Address Tree page Viewing Address Space, on page 11.

You can use the DHCP v6 Address Tree page to push and reclaim prefixes. Click the Push or Reclaim
icon for the desired prefix. (See Creating and Editing Prefixes for details.)

Tip

When you click the Current Usage tab, the utilization detail appears.

To ensure the proper prefix-to-server mapping on this page, you must update the regional address space
view so that it is consistent with the relevant local cluster. Do this by pulling the v6 replica address space
or pushing the prefix to the DHCP server. Also ensure that the particular DHCP server is running.

Note
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The other columns under the Current Usage tab identify:

• Range—Address range of the prefix.
• Type—Whether the address space is a prefix or link.
• Active Dynamic—Addresses that are part of a dynamic range managed by DHCP and that are currently
leased, but not reserved.

• Active Reserved—Appears at the regional cluster only. Addresses that are part of a dynamic range and
are reserved.

• View Utilization History—Appears at the regional cluster only. Clicking the Report icon ( ) opens
the Utilization History Details page.

In the Current Usage tab, the Utilization Detail column are expandable so that you can view the prefix or
parent prefix data. If you click the View Details icon ( ) next to the prefix or the parent prefix in this column,
this opens the Utilization Details page for selected item.

The Utilization Details page is a read-only page that shows detailed address utilization attributes for the prefix
or the parent prefix (identified as Totals). If you want to drill down to the actual breakup of the usage, you
can click the View Details icon on the row and an overlay with the breakup in the form of a chart with
appropriate legends is displayed. You can hover on different parts of the chart to get more details about that
particular type of usage. Click the Table tab to view the address utilization attributes described in the table
below.

Table 3: Address Utilization Attributes

DescriptionUtilization Attribute

Tenant owner of this prefix.Tenant

Granularity of the utilization data. Prefix-level indicates the data is for the
specific prefix; totals indicates the data is for the parent prefix, which is the
sum of its prefix-level counters.

aggregation-level

DHCP address assignment type, which can be dhcp (stateful), stateless (option
configuration), prefix-delegation, or infrastructure (maps a client address to
a link without an address pool).

dhcp-type

Total Addresses

Total number of dynamic leases in active use (leased, offered, released, expired,
or revoked. The Active Dynamic category shows the states of these leases.

active-dynamic

Total number of reserved leases.total-reserved

Active Dynamic

Number of dynamic (unreserved) leases that are currently offered to clients,
but not yet acknowledged as being leased.

offered

Number of dynamic leases that are currently acknowledged as leased to clients.leased

Number of dynamic leases that are past the lease expiration period, but will
not be available for other clients (except after the policy grace-period expires).

expired

Number of dynamic leases that the client can no longer use, but that some
other client could be using.

revoked
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DescriptionUtilization Attribute

Reserved

Number of reserved leases that clients are actively using.reserved-active

Number of reserved leases that clients are not actively using.reserved-inactive

Unavailable

Number of unreserved dynamic leases that a client declines or the server marks
with an address conflict (usually indicating configurations that need correcting).

unavail

Number of reserved leases that a client declines or the server marks with an
address conflict (usually indicating configurations that need correcting).

reserved-unavail

Deactivated

Number of dynamic and reserved leases that clients are actively leasing (that
are not offered, expired, or released), but that an administrator deactivated.

deactivated

Number of dynamic leases that an administrator deactivated.leased-deactivated

Number of reserved leases that an administrator deactivated.reserved-leased- deactivated

Prefix Delegation Lease Counts

Prefix length used for counting the prefix delegation leases.max-pd-balancing-length

Number of prefixes, of the max-pd-balancing-length prefix length, that are in
use.

prefixes-in-use

Number of prefixes, of the max-pd-balancing-length prefix length, available
to any client on this server.

prefixes-available

Number of prefixes, of the max-pd-balancing-length prefix length, available
to any client on the failover partner.

prefixes-other-available

Number of prefixes, of the max-pd-balancing-length prefix length, in transition
between the failover partners.

prefixes-in-transition

Failover Related

Number of prefix delegation leases available to any client on this server. This
is the count of the number of lease objects and not the number of prefixes of
a specific prefix-length.

available

Number of prefix delegation leases that this server believes the partner has
available to any client.

other-available

Number of leases that are in the pending-available state.pending-available

Number of leases that are in the pending-delete state.pending-delete

Additional Attributes
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DescriptionUtilization Attribute

Local cluster that reported this utilization data.cluster-id

Link for this prefix-level utilization data.link-name

Owner associated with this prefix or link.owner

Region associated with this prefix or link.region

Comma-separated list of selection tags associated with prefix-level utilization
data.

selection-tags

Time when this utilization data was collected.timestamp

Generating Utilization History Reports
You can extract utilization history data so that you can determine how many addresses in the subnet were
allocated and what the free address space is. You can use additional administrative functions to trim and
compact the utilization database of records, to manage the size of the database.

Related Topics
Querying Utilization History Data, on page 17

Trimming and Compacting Utilization History Data, on page 18

Querying Utilization History Data
When local is registered with regional or on default poll (every 1 hour) or on manual poll, the DHCP utilization
data is collected. All available scope and prefix information will be collected by the regional server.

By default, polling is enabled for all clusters, because these values are unset on the cluster object when it is
created. The global settings on the regional CCM server control the polling interval and offset for all clusters
when the values are not set. Setting these values on the local cluster overrides the server default value. If
addrutil-poll-interval is set to 0, this disables polling for that cluster.

Regional Web UI

Step 1 You must set the selection criteria for querying the utilization data—In the Advanced mode, from the Operate menu,
choose DHCP Utilization History under the Reports submenu. This opens the Query Utilization History page.

Step 2 You can query the v4 and v6 utilization history by enabling the v4 History or v6 History radio button. Also, you can
query utilization history based on the following criteria:

a. Time range—Choose from one of the following time ranges for the lease history data:

• Today

• last 10 days

• last 30 days
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• last 60 days

• last 90 days

• from/to (limited to 90 days)

If you choose this value, also choose the Start Date and End Date month, day, and year from the drop-down
lists. The result depends on the value of the addrutil-poll-interval attribute.

b. Owner—Choose the owner from the adjacent drop-down list.
c. Region—Choose the region from the adjacent drop-down list.
d. Aggregation Level—Choose the aggregation level from the adjacent drop-down list.
e. Subnet—Choose the subnet from the adjacent drop-down list.
f. Cluster—Choose the cluster from the adjacent drop-down list.

Step 3 Choose the filter Attribute and the Type from the drop-down lists and enter the value of the filter Type selected in the
Value field. Then click the + icon to add the filter. If there is any existing custom filter, you can click the X icon next to
it to remove the filter.

Step 4 Click Apply Filter to display the results. You can click the Report icon ( ) in the View Details column to open the
Utilization History Details page.

Trimming and Compacting Utilization History Data
The subnet and prefix utilization history databases are trimmed automatically. The CCM server performs
background trimming at the regional cluster, which trims off the utilization data older than a certain age at
regular intervals. The trimming interval is preset to 24 hours, and the age (how far back to go in time before
trimming) to 24 weeks.

You can also compact records older than a certain age to reduce the amount of history that is stored. Only the
first data point will be retained for each compact interval. All other data points will be deleted.

You must be a central configuration administrator assigned the database subrole to adjust the values of and
perform utilization database trimming and compacting.

Regional Advanced Web UI

Step 1 From the Operate menu, choose Manage Servers under the Servers submenu to open the Manage Servers page.
Step 2 Click the Local CCM Server link in the Manage Servers pane on the left, to open the Edit Local CCM Server page.
Step 3 Under the Address Utilization Settings, set the following attributes:

a) addrutil-poll-interval—How often to collect subnet and prefix utilization from all the DHCP servers. If it is set to 0,
the polling is disabled.

b) addrutil-poll-retry—The number of retries for a given polling interval, if polling fails.
c) addrutil-poll-offset—Provides a fixed time of day for subnet utilization polling. This time is interpreted as a time of

day offset, with 0 being 12 midnight, provided the polling interval is less than 24 hours, and the offset value is less
than the polling interval. If the offset value is greater than the polling interval, or the interval is greater than 24 hours,
the offset will be ignored.

The scheduler for polling will ensure that the first polling event occurs at the offset time. For example, if you set the
interval to 4 hours and the offset to 2am, the polling would occur at 2am, 6am, 10am, 2pm, 6pm and 10pm.

Managing Address Space
18

Managing Address Space
Trimming and Compacting Utilization History Data



d) addrutil-trim-interval—How often to trim the old subnet and prefix utilization data automatically, the default being
not to trim the data. You must set this to a value to trigger any background trimming. The bounded values are 0 to
one year, and you can use units in seconds (s), minutes (m), hours (h), days (d), weeks (w), months (m), and years
(y).

e) addrutil-trim-age—How far back in time to trim the old subnet and prefix utilization data automatically, the preset
value being 24 weeks. (However, the addrutil-trim-interval value must be set to other than 0 for trimming to be in
effect at all.) The bounded values are 24 hours to one year, and you can use units in seconds (s), minutes (m), hours
(h), days (d), weeks (w), months (m), and years (y).

Step 4 You can also force immediate trimming and compacting. Find the Trimming/Compacting section:
a) Trim/Compact age—How far in time to go back to trim the data. There are no bounds to this value. However, if

you set a very small value (such as 1m), it trims or compacts very recent data, which can be undesirable. In fact, if
you set it to zero, you lose all of the collected data. Setting the value too high (such as 10y) may end up not trimming
or compacting any data.

b) Compact interval—Time interval at which to compact the subnet and prefix utilization records older than the
Trim/Compact age. This interval can be some multiple of the polling interval. For example, if the compact interval
is set to twice the polling interval, it eliminates every other record.

Step 5 If you are trimming immediately, click Trim All Utilization Data among the controls at the bottom of the page. If you
are compacting the data, click Compact All Utilization Data.
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